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Background: The chronic liver disease is one of the most deadly diseases in 

Egypt and around the world; perfect diagnosis methods are urgently needed. 

The proper assessment of liver fibrosis offers acute information for both 

perfect diagnosis and accurate therapeutic decision-making. Although digital 

image analysis (DIA) is a promising method for quantitative assessment of 

liver fibrosis, it has not been fully evaluated in practice yet. The present 

study was designed to explore the possibilities of using open access image 

analysis software (ImageJ) for accurate quantitative assessment of liver 

fibrosis.  

Methods: This study investigated the use of digital images analysis by 

software ImageJ of liver sections stained by sirius red (SR). Reproducibility 

of this technique was tested in comparison with the a semi-quantitative score 

of liver fibrosis as well as other markers of fibrosis including physiological 

markers of liver functions such as alanine transaminase (ALT), aspartate 

aminotransferase (AST), alkaline phosphatase (ALP), gamma-glutamyl 

transferase (GGT). In addition, it was tested compared to serum marker 

collagen IV (Col IV) and hepatic hydroxyproline. Results:  From 

physiological point of view; hepatic hydroxyproline, serum Col IV and ALT 

showed higher accuracy, sensitivity and specificity than other physiological 

markers with area under curve (AUC) of 0.935, 0.955 and 0.902 respectively. 

On the other hand, DIA of SR by ImageJ software had shown the best 

accuracy with AUC of 1.0.  

In conclusions: our novel data prove that the use of ImageJ with 

semiautomatic color segmentation is a reliable and practical way of 

measuring collagen proportionate area. 

 
                   Copy Right, IJAR, 2016,. All rights reserved.

 

Introduction:- 
Liver fibrosis is known as the formation of too much quantity of extracellular matrix, forming scar tissue, in the liver 

parenchyma (1). Advanced liver fibrosis may lead to cirrhosis, liver failure, and portal hypertension and often end 

up with liver transplantation (2). Therefore, the accurate quantification of fibrous tissue in liver sections is essential 

for both investigational and clinical studies. Several studies have attempted to categorize serum markers that 

associate with the amount of fibrosis and thus could be used, with feasibility, with liver biopsy or could substitute it 

(3). Currently, semi-quantitative scoring systems can be used to evaluate the degree of fibrosis (4-6). Such scoring 

systems are subjective, requiring an experienced pathologist exhibiting significant inter- and intra-observer variation 

(7). In addition, it lacks the accurate evaluation of fine morphological details that could be done by a purely 

quantitative technique. As a result, recent studies have used computerized image analysis to assess hepatic fibrosis 

to overcome this problem. These quantitating methods aimed to be more accurate than, those determined by semi-

quantitative scoring methods, without requiring the presence of an experienced pathologist (8).  

 

http://www.journalijar.com/
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The current study was designed to explore the possibilities of using open access image analysis software for 

quantitative assessment of CPA in liver tissue sections in correlation to physiological fibrotic markers and a semi-

quantitative scoring system of liver fibrosis induced experimentally using carbon tetrachloride (CCl4). In addition, 

an open-access software for image analysis was used for quantitative assessment of CPA in liver tissue sections 

stained with SR. 

 

Materials and Methods:- 
Chemicals:- 

Carbon tetrachloride was purchased from lobachemie (Mumbai, India). Chloramine-T, p-

dimethylaminobenzaldeyde (Ehrlich’sreagent), sodium acetate, citric acid, trisodium citrate, perchloricacid, 

isopropanol, sodium hydroxide, and acetic acid were purchased from Fisher scientific (St. Louis, USA) and trans-4-

hydroxy-L-proline were purchased from Sigma–Aldrich (St. Louis, USA).  

 

Animals:- 

Adult male Wistar rats (150-180 g) were given free access to tap water and food. All animals received humane care 

in compliance with the NIH and the Research Ethics Committee Criteria for Care of Laboratory Animals at Nile 

Center for Experimental Research, Mansoura, Egypt. 

 

Experimental design :- 

 (In this experimental study, forty eight male Wistar rats were divided into 6 equal groups (each 8 rats) as follow; 1‏

Normal control group: served as normal healthy rats that did not receive any treatment, 2) Vehicle-treated group: 

these were treated with olive oil, 3) CCl4 (2W) group: received CCl4 intraperitoneally (0.5 ml/kg) twice a week in 

olive oil for 2 weeks (9), 4) CCl4 (4W) group: received  CCl4 in olive oil for 4 weeks, 5) CCl4 (6W) group: received 

CCl4 in olive oil for 6 weeks and 6) CCl4 (8W) group: received CCl4 in olive oil for 8 weeks. At the end of the 

experimental period for each group, rats were anaesthetized by diethyl ether and sacrificed. Blood samples of each 

rat were withdrawn in test tubes. The tubes of blood were left for coagulation then centrifuged at 3000 rpm for 15 

minutes to obtain serum for further biochemical analysis. The abdomen was opened through a midline laparotomy 

and the liver was rapidly removed, washed with normal saline. Part of the liver was placed in 10% formalin for 

histopathological examination and the other part was stored in liquid nitrogen (-196ºC) for further analysis of 

hydroxyproline content in liver homogenates.  

 

Biochemical markers of liver injury:- 

The serum activity of ALT, AST, ALP and GGT was determined using a commercial kit in accordance with 

manufacturers’ instructions (ELITech Group, Paris, France). The serum activity of Col IV was determined using a 

commercial kit in accordance with manufacturers’ instructions (Uscn Life Science Technology, Wuhan, China). 

 

Measurement of hepatic 4-hydroxyproline content:- 

Hepatic 4-hydroxyproline content was quantitated colorimetrically using the chloramine T method as previously 

described by Lee, Shun (10) with minor modifications (11). In brief, liver specimens (50 mg) were weighed in 

Eppendorf tubes and hydrolyzed in 0.5 ml of 2 N NaOH at 100° C for 2 hr. The hydrolysate was then cooled and 

centrifuged at 8000g for 10 min. 

 

Chloramine T solution was prepared by dissolving 1 part of 7% chloramine T to 4 parts of citrate/acetate buffer (pH 

6.0, 57 g sodium acetate, 37.5 g trisodium citrate, 5.5 g citric acid, 385 ml of isopropanol, and dissolved in H2O to a 

final volume of 1 L)]. Two hundred microliters of the supernatant was added to 0.125 ml of the prepared chloramine 

T solution and then was incubated at room temperature for 10 min. Thereafter, 0.75 ml of Ehrlich’s solution was 

added. The Ehrlich’s solution was prepared by dissolving 2 g of P-dimethylamino-benzaldehyde in 3 ml of 60% 

HClO4 and then mixed with 9 ml of isopropanol. The final mixture was incubated at 60 ºC for 35 min, then at room 

temperature for 10 min. The mixture absorbance was determined at 560 nm. Standard solutions containing authentic 

4-hydroxy-L-proline were treated likewise. The standard curve was linear in this range (r = 0.99). The value of 

hepatic 4-hydroxyproline content was expressed as µg/g wet tissue. 

 

Hepatic histopathological evaluations:- 

Portions of livers were fixed in 10% neutral buffered formalin solutions for 24 hr. Standard histopathological 

techniques were followed for processing the tissue and preparation of paraffin blocks. Fibrosis and CPA were 

evaluated in sections (5 lm thick) stained with SR using the score of Zhao et al, with modification (12). The 

https://www.google.com.eg/search?safe=off&q=colorimetrically&spell=1&sa=X&ved=0ahUKEwjzhd6-1KLKAhXIuRoKHTfqAGoQvwUIGSgA
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following scores were used to quantify fibrosis: F0 – no fibrosis; (F1) Central only in some lobules; (F2) Central 

only in most of the lobules; (F3) Central with short septa without bridging; (F4) Central fibrosis with bridging 

central –central; (F5) formation of cirrhotic nodules by fibrous septa which are delineating the portal lobule; (F6) 

Focal sub-segmentation of the portal lobules; (F7) Diffuse sub-segmentation of portal lobule; (F8) small separate 

cirrhotic islets separated by wide fibrous septa. 

 

Image acquisition :- 

All slides were examined by a light microscope Olympus model Cx31rtsf (Tokyo, Japan) and image acquisition was 

done by digital camera (Olympus Epl1, Japan) at a resolution of 4032×3024 pixels = 12192768 attached to a light 

microscope (Olympus Cx31rtsf) connected to a compatible personal computer Intel Core i3-2350M (2.3 Ghz, 4 Gb 

memory PC running on Microsoft windows 7). For each tissue type, a number of 5 images of random low-power 

fields (x40)/specimen of liver were saved from the digital slides in JPG (Joint Photographic Experts Group) format. 

The fibrosis ratio was the total area of fibrosis (Afib) divided by the total area of the section. 

 

Image processing:- 
Image analysis methods were performed using ImageJ software; version 1.48d (developed by Wayne Rasband, 

National Institutes of Health, Bethesda, Maryland, USA) (13) and Java (64-bit) engine. This software was chosen 

since it is freely available and is platform independent.

 

Results::- 
1. Physiological Markers:- 

Mean values of serum markers activity of liver functions including, ALT, AST, ALP, GGT, are shown in figure 1. 

Insignificant differences were demonstrated between normal and vehicle-treated groups (p <0.001). Treatment with 

CCl4 induced a significant dose-dependent increase in the activity of serum ALT, AST, ALP and GGT and in the 

progressing of fibrosis stage reaching a maximum at the eighth week.  

  Mean values of serum Col IV and hydroxyproline content in liver tissues are shown in figures 2. They 

showed insignificant difference between normal and vehicle groups (P≤ 0.001). Moreover, the current data 

demonstrated gradual increase in the serum Col IV and hydroxproline content with increasing the dose of CCl4 that 

corresponds to fibrosis progression. In order to identify the most accurate physiological marker, data was analyzed 

by means of the ROC curve, as shown in Table 1.  

Description of DIA method 

 

a. Image phases:- 

After launching ImageJ picture editor and processing tool, the desired microscopic digital image is opened either by 

File > Open or by simply dragging the image to ImageJ's toolbar. Image segmentation of RGB image into different 

channels is based on the split channels parameter using the command Image> color> split channels. The simplest 

way of segmentation is based on the difference in the intensities of objects and background. This resulted in splitting 

the image into three 8-bit grayscale images containing the red, green and blue components of the original are 

performed. The green channel provided the best separation of these regions to isolate collagen. 

 

To fix an uneven background the image was adjusted based on subtracting background parameter using the 

command Process >subtract background. The rolling radius used was 100, only the light background option has 

been checked (figure 3).  Then a binary mask that contained only two values of the resulted subtracted image was 

done using process > binary > make binary. The first value signified that the pixel belonged to the background and 

the second signified that a pixel belonged to the object. To reverse black and white regions Edit>invert as it involves 

flipping' the intensities: making the higher values lower, and the lower values higher. To reverse black and white 

regions the command Edit>invert was used as it involves flipping' the intensities. After that the command 

Edit>Selection>Create Selection was used to create a selection from the inverted image so that fibrotic areas was 

identified from the background. It represented the borders of the objects we were interested in (figure 4). 

 

Finally, before doing measurement the parameter to be measured, area and Limit to threshold, was set using 

Analyze > Set Measurements (figure 5). Measurements chosen were performed using the command Analyze > 

measure. ImageJ displays the results in a separate window (Results) that may be saved in one of the popular data 

storage file formats (e.g. csv or xls). This data is then available for further statistical analysis and data mining. 

 

http://www.scielo.br/scielo.php?pid=S0004-28032010000200009&script=sci_arttext#tab03
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b. Creating Macros for Sirius Red :- 
While performing all steps mentioned before on phase two for SR stain, they were automatically recorded on the 

opening window using the command Plugins > Macros > Record.  The recorded macro was saved in the plugin 

folder by using the editor's File>Save As command. Macrocode is stored in text files (.txt and .ijm extensions). 

ImageJ automatically installed the macros when it started up which was follow: run("Split Channels"); run("Close"); 

run("Subtract Background...", "rolling=100 light"); set Option("Black Background", true); run("Make Binary"); 

run("Invert"); run("Create Selection"); run("Set Measurements...", "area limit display redirect=None decimal=9"); 

run("Measure");.  

 

c. Statistical analysis for DIA of SR  

Mean values of CPA by ImageJ in liver sections stained with SR is shown in figures 6. CPA determined by ImageJ 

showed significant elevation in CCl4 treated groups compared to normal control and vehicle -treated groups (p ˂ 

0.001). Also, strong correlation was found between serum marker ALT, AST, ALP, GGT, col IV and 

hydroxyproline and DIA of SR (Figure 7). Moreover, the AUC for DIA of SR was 1.00 at cut off value 1.35. In 

addition, the sensitivity for DIA of SR was 100% while the specificity was 100%. 

d. Statistical analysis for fibrosis score  

Mean values of histopathological scoring examination of fibrosis in the liver sections stained with SR are shown in 

figure 8 and Table 2. Fibrosis scoring index of SR stain showed significant elevation in CCl4 treated groups 

compared to normal control and vehicle-treated groups (p ˂ 0.001). In addition, there was positive correlation 

between fibrosis score index and DIA of SR (Figure 9). 

 

Discussion:- 
Liver biopsy represents the gold standard for damage evaluation, but noninvasive serum markers that show liver 

fibrosis progression are actual goals both in adults and especially in children. Carbon tetrachloride (CCl4) is one of 

the most commonly used hepatotoxins in the experimental study of liver diseases. Many studies have shown that 

CCl4 administration in the rat increased the serum activities of ALT, AST, ALP and GGT when compared to control 

(14-19). This was confirmed in the current study in which measuring serum activity of ALT and GGT was more 

specific than AST and ALP for fibrosis according to their AUC values.  

 

These parameters does give information about important aspects of liver function however, they do not assess 

severity of liver fibrosis or cirrhosis (20). In the study of Lu, Zeng (21) the activities of ALT, AST, ALP and GGT 

were all related to the staging of fibrosis. In a study of 456 patients with Chronic Hepatitis B (CHB), AST and ALT 

showed a significant correlation with advanced fibrosis (22).  In another study by Huang et al (2013) (32), it 

correlated eight serum markers (GGT, HA, α-macroglobulin, ALT, AST, platelet count, prothrombin time and 

albumin) with CPA of SR and masson trichrome. This is with agreement with the present study where ALT, AST, 

ALP and GGT activity show a positive correlation with values of image analysis of liver sections stained SR.  

 

Type IV collagen is one of the most abundant proteins in the ECM that was investigated as a surrogate marker of 

liver fibrosis (23). Many studies have shown that administration of CCL4 could cause increase in concentration of 

serum Col IV (24-26). This was in agreement with the findings of the present study, which demonstrated gradual 

increase in the serum type Col IV with advancing stage of fibrosis. The accuracy, specificity and sensitivity for 

serum Col IV were 0.955, 96% and 87% respectively. In addition, a positive correlation was demonstrated with the 

CPA measured by ImageJ in SR stained liver tissue. These findings are in agreement with Murawaki, Ikuta (27) who 

reported that the serum Col IV level was better for differentiating moderate or severe fibrosis from no or mild 

fibrosis in HCV with AUC = 75%. Also, same findings were demonstrated by Li, Piao (29). It demonstrated that 

serum Col IV increased significantly in hepatic fibrosis (dimethyl nitrosamine model) at week 1,2,3,4 and a positive 

correlation was recorded between the CPA measured by CMIAS image analysis system in SR stained tissue and 

serum levels of Col IV. These findings suggest that measurement of serum Col IV could be a reasonable index for 

assessment of liver fibrosis. 

 

The alteration of hydroxyproline levels in the liver is considered as an index of collagen metabolism and give useful 

information about the biochemical and pathologic events of hepatic fibrosis (30). A gradual and progressive increase 

in the hydroxyproline content in the liver tissues significantly demonstrated as the CCL4 dose increase and fibrosis 

became more advanced. In addition, a significant positive correlation is observed between digital image analysis 

(DIA) of SR and hydroxyproline levels in the corresponding liver tissues. Matching findings were demonstrated by 

Nakayashi, Takamatsu (31) indicating a highly significant correlation between the biochemically measured 
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hydroxyproline content of liver samples and the CPA of double stain of SR and Fast green  SF stain. Also, 

hydroxproline showed a significant positive correlation with the staging scores proposed by Zhao, Wang (12). 

 

Little universally acceptable criteria exist for animal models, (12) scoring system was used to assess the severity of 

fibrosis in CCl4 and dimethyl nitrosamine models in rats. This seven-stage criterion has its own pathological features 

that can be distinguished morphologically. The degree of fibrosis in this study is recorded on the basis of the Zhao et 

al scoring system for staging of fibrosis in CCl4-induced liver fibrosis in rats with some modifications. Fibrosis 

scoring index, in the current study, showed significant elevation in the all CCl4-treated groups compared with the 

control value (p ˂ 0.001). It had shown an AUC of 1 with 100% and 100% sensitivity and specificity, respectively. 

In addition, there was a significant positive correlation was demonstrated between the staging scores and increased 

relative fibrous areas in liver tissue for SR (r = .918, P < 0.001). These findings are in agreement with that reported 

by Zhao et al. (12) in which a significant positive correlation was demonstrated between the staging scores and 

increased relative fibrous areas in liver tissue specimens in the rat model (r = 0.919, P < 0.001).  

 

Digital morphometry, in contrast to other morphologic methods, use personal computers and specific software, to 

perform precise and highly reproducible results and provide results in mathematical format (28). Several studies 

have attempted to correlate the image analysis measurements of fibrosis with the categorical stage scores. In a study 

by Huang, de Boer, SR stain could detect delicate fibrous septa better than trichrome. Both CPA of SR and CPA of 

Masson Trichrome correlated well with Metavir stage, whereas CPA of SR had better ability to detect cirrhosis with 

AUC of 0.95(33). 

 

Recently, in the study of Huang, de Boer (34) to predict adverse clinical outcomes in CHC patients with all stages of 

fibrosis, CPA in SR stained liver tissue measured by Aperio Image Scope software showed a significant correlation 

between CPA and metavir stage. It also showed an excellent predictive ability for hepatocellular carcinoma 

development with an AUC of 0.92, which was significantly higher than that of metavir stage. This was in agreement 

with the present study where CPA of SR had excellent predictive ability for liver fibrosis detection with AUC of 

1.00.  

 

The present study presented a practical approach to perform image analysis of SR stained liver tissue. ImageJ 

software was chosen because is freely available along with extensive documentation. Additionally, the current study 

presented the required steps in order to perform the method. Moreover, it is possible to turn the manual method to 

automated one by recording it as a macro. The present findings confirm the validity of using ImagJ over the routine 

histopathological examination by pathologist. The examination is easy so that a technician can perform it. 

 

From physiological point of view, hydroxyproline, Col IV and ALT showed the higher accuracy, sensitivity and 

specificity so it can be used for liver fibrosis diagnosis. In addition to being substantially less invasive, with no risk 

of complications, eliminate sampling errors and observer variability. Moreover, measurements may be performed 

repeatedly and used in monitoring of fibrosis. However, as none are liver specific their results can be affected by 

comorbid conditions, requiring critical review for false positive and false negative results (31). 
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Figure legends:- 

 

Figure 1: Serum activities of different physiological marker in the control and CCl4-treated groups 

Figure 2: Serum col IV and liver Hydroxyproline content in the control and CCl4-treated groups 
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Figure 3: ImageJ's Analyze subtracting background setting panel 

Figure 4: By choosing only the green channel to complete the DIA for the original image, Different steps of image 

processing starting from subtracting the background (A), converting the image to a binary image (B), reversing 

black and white regions (C) and finally creating a selection from the inverted image so that fibrotic areas can be 

identified from the background (D). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5:  ImageJ's Set Measurements settings panel 
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Figure 6: Mean values of CPA by image analysis by ImageJ software for liver sections stained with SR in in the 

control and CCl4 treated groups. 

Figure 7: Correlations between different physiological marker and image analysis by SR 
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Figure 8: Fibrosis score index of SR in the control and CCL4 treated groups  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 9: Correlations between pathological fibrosis score and image analysis 

 

 

Table legends:- 

Table 1: AUROCs for different physiological markers of fibrosis. 

Marker Cut off Sensitivity Specificity AUC  

ALT 132 81.3% 87.5% 0.902 

AST 115.5 81.3% 81.2% 0.852 

ALP 279 84.4% 87.5% 0.888 

GGT 2.95 90.6% 81.2% 0.930 

Col IV 29 96.9% 87.5% 0.955 

Hydroxyproline 298.8 93.8% 81.2% 0.935 
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Table2: Fibrosis score index 

 

Appearance Score I.A 

 

 

F0 

normal control group where 

central veins are very minimally 

encircled by fibrous tissues with no 

septa nor bridges 

 

.36% 

 

F2 

pericentral fibrosis is located in 

most of the central veins 

 

2.1% 

 

F3 

short septa of pericentral fibrosis 

extend from the central vein but 

not connected to other central veins 

 

2.4% 
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Conclusion:- 
In conclusion, morphometric assessment of CPA is accurate and reproducible method for evaluating fibrosis in liver 

biopsies. There is a significant correlation between the morphometric image analysis of the percentage area of 

fibrosis and the staging system of fibrosis in liver, serum Col IV as well as hydroxyproline content in liver and liver 

function enzymes (ALT, AST, ALP and GGT). 

 

Abbreviation:- 
ALP: alkaline phosphatase; ALT: alanine transaminase; AST: aspartate aminotransferase; AUC: area under curve 

CCl4: Carbon Tetrachloride; Col IV: collagen IV; DIA: Digital image analysis; GGT: gamma-glutamyl transferase; 

SR: sirius red. 
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F4 

Central-central bridging by 

fibrosis septa 

 

4.1% 

 

F5 

septa join central veins to form 

nodules corresponding to the 

portal lobules 

 

4.3% 

 

F6 

fibrous septa form nodules 

corresponding to the portal lobules 

with focal sub segmentations 

 

5.3% 
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